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New and Changed Features for Bria 3.2 

Installer 
The size of the Bria 3.2 installer is down to 22MB.  

Contacts and the Contact List 
Contacts from Multiple Sources 

• Bria 3.2 allows you to pull in contacts from more than one source: from contacts stored locally, from your 
Outlook address book, from a WebDav or XCap server. Previously, you had to choose one from among these 
options. 

Support for the Outlook Address Book 

• Following from the change described above, you connect to your Outlook address book differently in Bria 
3.2: you create an Outlook account for it. (Softphone > Accounts and click Add > New Outlook Account).  

• When you open a contact in Bria that comes from the Outlook address book, the regular Bria Contact Profile 
opens. (Previously, the Outlook contact dialog opened.) You can add information to the contact in Bria, but 
this information is not copied over to your Outlook address book. In other words, Bria pulls information from 
Outlook but it does not push information into Outlook. 

Merged Contacts 

If you have contact information for a person that comes from two sources, two contacts are created. However, you 
can merge these contacts into one contact. You can also split (unmerged) a merged contact.  

Contact List Display 

• You can view contacts in a compact or an expanded view. 

• The options for viewing the contact list have moved from a drop-down menu in the contact list to 
Main menu > Contacts. 

 
Actions with Contacts 

• You can assign a “primary action” to contacts: phone or IM. This feature applies to all contacts and is set in 
Preferences > Application. (Previously, you can assign the action differently for each contact.) 
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• If a contact has more than one phone number and/or more than one presence address (see below for more 
information on multiple presence), you designate a primary phone number and/or primary presence address. 
The primary action uses the primary number or address. 

• Double-clicking a contact performs the primary action. 

• Each contact includes up to three icons to support “single-click” calling and instant messaging. Hover over 
the contact and click the icon to contact the person using the contact’s primary number or address:  

 

Presence 
• Presence on multiple accounts. With Bria 3.2, you can set up presence on more than one account. Previously, 

you could set up presence on only one account: SIP or XMPP. Now you can set up presence on as many 
accounts as you want. 

• Multiple XMPP accounts. With Bria 3.2, you can set up more than one XMPP account. 

• An individual contact can have multiple presence addresses, for example, a SIP address and one or more 
XMPP addresses (perhaps the person’s address on the corporate XMPP server and their address on a personal 
account such as Gmail™ webmail service. If you have created corresponding accounts for yourself (for 
example, if you have created an XMPP account using your Gmail user credentials), then you can subscribe to 
as many of these presence addresses as you want. 

• If a contact has multiple presence addresses, the presence icon on the contact list is tied to one of these 
addressees (the address you designate as the primary address). However, you can still use the other addresses 
to IM that person. 

LDAP Directory and Active Directory 
• Previously, when you created contacts from directory entries, you could choose whether or not you wanted to 

automatically synchronize the contact with the directory entry. With Bria 3.2, contacts are always 
synchronized with directory entries.  

Calls 
The volume control is now on the dashboard, instead of on the call panel for each individual call. In addition, 
audio levels (microphone and speakerphone) are shown even when a call is not in progress. 

XMPP Chat Rooms 

Bria 3.2 supports XMPP chat rooms: if the user has an XMPP account or accounts, and the XMPP server supports chat 
rooms, then the user can join a chat room from Bria. To view chat rooms, choose View > Chat rooms. 

For the user to join a chat room from Bria the room must be set up on the server (ad-hoc chat rooms are not supported). 
The following features are supported: 

• Open chat rooms: user can join without being set up as a member on the server. 

• Members-only chat rooms: user can join only if set up as a member on the server. 

• Password-protected (confidential) chat rooms: user must enter the password to join. 
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Workgroups 
Workgroups are now supported in peer-to-peer mode as well as server mode. (Previously, they were supported 
only on a server, which requires that a system administrator set up workgroups on an RLS and add members.) 

With peer-to-peer mode, Bria users can set up their own workgroups. Typically, everyone in a given group will 
informally agree to add each other to the group so that everyone’s setup contains the same workgroup numbers.  

To set up a workgroup in peer-to-peer mode, choose Preferences > Presence and complete the required fields. 

Once a workgroup is set up, it functions in the same way in either server mode or peer-to-peer mode. 

Bria Add-In for Outlook™ 
You can install this Add-in when installing Bria, assuming that you have Microsoft Outlook™ on your computer. 
Bria Add-in appears as a panel in the To-Do bar of your Outlook window.  

 
• You can dial a phone number in the Add-in panel and place a call (an audio call, video call, or conference 

call). Bria will come to the front (or it will start) and place the call.  

• Once a call is established, you can end the call from within the Add-in panel. To manage the phone call in any 
other way (hold, and so on), you must switch to the Bria softphone call panel. 

• Bria Add-in recognizes names and numbers in a selected e-mail or calendar entry. It 

• Recognizes names that are Outlook contacts and numbers that look like phone numbers and displays these 
items in the Add-in. You can select one of these items and phone that person. 

• Recognizes names (that are not already contacts) and phone numbers and lets you add these people to 
your Outlook contact list. 

• The Bria Add-in panel will display an icon when you have missed a call or when you have voicemail. You 
can click the icon to view the Bria History panel or to call voicemail. 
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New and Changed Features for Bria 3.2.1 

Contact Editor and Presence Handling 
With Bria 3.2, if you add an XMPP address (Instant Message address) to a contact and you wanted to enable 
presence on that address, you clicked the Enable XMPP Presence button.  

With Bria 3.2.1, the button has been removed. Instead, when you add an Instant Message address, the following 
prompt automatically appears. To enable presence, you simply press Continue. If you do not want to enable 
presence, you unclick the field and then click Continue.  

 

Calling from History 

Sometimes a call is received on Bria using a domain that cannot be called back on. For example, a call 
received on the MyVoipProvider account may actually have the phone number 
5551234@MVPserver1.com. When the user tries to call this number from the History entry, the call 
fails because the domain MVPserver1.com cannot accept incoming calls. 

In Bria 3.2.1, an improvement has been made to improve the chances that this call will succeed. For 
example, Bria will attempt to call 5551234@MVPserver1.com (the number as it was received), then 
5551234@MyVoipProvider.com (the domain of the account the call came in on). 
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Known Issues 

Directory Searches 
If you are working in the Directory in Search on Demand mode and you switch to Type to Filter list, you must 
restart Bria. Otherwise, you will not be able to fetch the desired directory entries. (60594) 

Microsoft Windows Vista or Windows XP Guest Accounts 
You cannot use Bria on Windows Vista® or Windows® XP using the restricted “Guest” Windows account. 

V-cards and XMPP Account 

If the XMPP server supports v-cards they will be pulled in along with the roster when the XMPP account is 
enabled. If the v-cards are malformed, then Bria may crash when the XMPP account is enabled. 

ICE Incompatibility 

In some environments, Bria will not work with any other CounterPath client. (27161) 

Mobile Intel Express Graphics Chipset 

Computers with Mobile Intel® Express graphics chipsets that are running Windows XP may see visual artifacting 
when running Bria. This is a known issue with WPF graphics and this line of hardware. Bria will still operate 
correctly in this state when the Windows XP graphics acceleration is turned down: 

• Click Start > Control Panel > Display.  

• Click the General tab > click Advanced 

• Click the Troubleshoot tab and drag the slider to the None at the extreme left of the scale. You can also 
choose to turn down the hardware acceleration by selecting an intermediate value.  

• Click OK. 

Transferring with Multiple Accounts Enabled 

Currently, you cannot transfer a call made on one account by phoning the second person on a different account.  
For example, you establish a call with person A using account 1 (for example). You then try to transfer the call to 
person B by phoning person B on a different account. The transfer hangs and will not complete, and you will have 
to cancel the attempt to transfer. (33888) 

Codec Selection 

Currently, Bria does not select the best codec based on the available bandwidth and network conditions. When 
making an offer, Bria will offer all enabled codecs. When accepting an offer, Bria will accept the first supported 
codec from the offered list.  

Video Issues 

• Under certain scenarios, HD widescreen remote video will appear squished. 

• Video is not recorded properly on the Windows 7 operating system. The latest version of Windows Media® 
tries to use hardware acceleration wherever it can, so a bad driver may cause faulty playback which results in 
a green video screen. (39246) 

Using the Bria Add-in with 64-bit Outlook 

The Bria Add-in does not work with 64-bit Outlook. (55904) 
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Resolved Issues in Bria 3.2.1 
• In general, there have been improvements in the stability of Bria. 

• There was an issue with SIP presence via a presence agent not working with some PBXs. This problem has 
been resolved. (58433) 

• There was an issue with outgoing e-mails not being sent when the Bria Add-in for Outlook is enabled. This 
problem occurred when Outlook Tools > Options > Mail Set-up > “Send immediately when connected” is 
unchecked. This problem no longer occurs. (58328) 

• There was a problem with empty panels being created within the Contact Profile. This problem has been 
resolved. (57836) 

• There was a problem with the presence icon and the presence description becoming unsynchronized. For 
example, a contact was shown with the green available icon but the “on the phone” description. This problem 
has been resolved. 
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Third-party Software Notices 
AES 
This product includes software copyright (C) Mok-Kong Shen 2003. http://www.mokkong-shen.privat.t-
online.de/ 
The original software has been revised. A copy of the revised package is available at forums.counterpath.com.  

Ares 

This product includes software Copyright 1998 by the Massachusetts Institute of Technology. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without 
fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright 
notice and this permission notice appear in supporting documentation, and that the name of M.I.T. not be used in 
advertising or publicity pertaining to distribution of the software without specific, written prior permission.  

M.I.T. makes no representations about the suitability of this software for any purpose. It is provided "as is" 
without express or implied warranty. 

ATAPlugin Adapter DLL  
The product includes software Copyright (C) 2005-2006, Intel Corporation 

Crypto, Libeay, Libeay32, Open SSL 

This product includes software Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved. This product 
includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software 
written by Tim Hudson (tjh@cryptsoft.com). 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

 3. All advertising materials mentioning features or use of this software must display the following 
acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL 
Toolkit. (http://www.openssl.org/)" 

 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products 
derived from this software without prior written permission. For written permission, please contact openssl-
core@openssl.org. 

 5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names 
without prior written permission of the OpenSSL Project. 

 6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes 
software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)" 

 THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY EXPRESSED OR 
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, 
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, 
BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
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OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 

 ==================================================================== 

 

/ 

Original SSLeay License 

----------------------- 

/ Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) 

 All rights reserved. 

 This package is an SSL implementation written  by Eric Young (eay@cryptsoft.com). 

 The implementation was written so as to conform with Netscapes SSL. 

 This library is free for commercial and non-commercial use as long as the following conditions are aheared to. 
The following conditions apply to all code found in this distribution, be it the RC4, RSA, lhash, DES, etc., code; 
not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright 
terms except that the holder is Tim Hudson (tjh@cryptsoft.com). 

 Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this 
package is used in a product, Eric Young should be given attribution as the author of the parts of the library used. 
This can be in the form of a textual message at program startup or in documentation (online or textual) provided 
with the package. 

 Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met: 

 1. Redistributions of source code must retain the copyright notice, this list of conditions and the following 
disclaimer. 

 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

 3. All advertising materials mentioning features or use of this software must display the following 
acknowledgement: 

 "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)" 

 The word 'cryptographic' can be left out if the rouines from the library being used are not cryptographic related :-
). 

 4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) 
you must include an acknowledgement: 

 "This product includes software written by Tim Hudson (tjh@cryptsoft.com)" 

 THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND ANY EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO 
EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT 
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE. 
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 The licence and distribution terms for any publically available version or derivative of this code cannot be 
changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU 
Public Licence.] 

CURL 

This product includes software Copyright © Daniel Stenberg, daniel@haxx.se. All rights reserved.  

COPYRIGHT AND PERMISSION NOTICE 
  
Copyright (c) 1996 - 2008, Daniel Stenberg, <daniel@haxx.se>. 
  
All rights reserved. 
  
Permission to use, copy, modify, and distribute this software for any purpose 
with or without fee is hereby granted, provided that the above copyright 
notice and this permission notice appear in all copies. 
  
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, 
FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN 
NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE 
OR OTHER DEALINGS IN THE SOFTWARE. 
  
Except as contained in this notice, the name of a copyright holder shall not 
be used in advertising or otherwise to promote the sale, use or other dealings 
in this Software without prior written authorization of the copyright holder. 

DV14 

This product includes software copyright 1992 by Stichting Mathematisch Centrum, Amsterdam, The 
Netherlands. All Rights Reserved 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without 
fee is hereby granted, provided that the above copyright notice appear in all copies and that both that copyright 
notice and this permission notice appear in supporting documentation, and that the names of Stichting 
Mathematisch Centrum or CWI not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. 

STICHTING MATHEMATISCH CENTRUM DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS 
SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS, IN 
NO EVENT SHALL STICHTING MATHEMATISCH CENTRUM BE LIABLE FOR ANY SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM 
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR 
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE. 

Expat 

This product includes software Copyright (c) 1998, 1999, 2000 Thai Open Source Software Center Ltd and Clark 
Cooper 

Copyright (c) 2001, 2002 Expat maintainers. 
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Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions:  

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software.  

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR 
COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER 
IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

G.722 

This product includes software Copyright © 1996-2005  VoiceAge Corporation. All Rights Reserved. 

GSM 

This product includes software Copyright 1992, 1993, 1994 by Jutta Degener and Carsten Bormann, Technische 
Universitaet Berlin 

Any use of this software is permitted provided that this notice is not removed and that neither the authors nor the 
Technische Universitaet Berlin are deemed to have made any representations as to the suitability of this software 
for any purpose nor are held responsible for any defects of this software.  THERE IS ABSOLUTELY NO 
WARRANTY FOR THIS SOFTWARE. 

As a matter of courtesy, the authors request to be informed about uses this software has found, about bugs in this 
software, and about any improvements that may be of general interest. 

Berlin, 28.11.1994 
Jutta Degener 

Carsten Bormann 

iLBC 

This product includes software Copyright © 1999-2005 Global IP Sound Inc. All Rights Reserved .  

All use of the Original Code (GIPS iLBC, and code provided by GIPS as part of any related IETF Standard or 
draft standard) is subject to the complete Global IP Sound iLBC Public License, IETF Standard, Limited 
Commercial Use (the (License”). 

The Source Code version of the Original Code is available under the terms of the Global IP Sound Public License, 
v2.0, IETF Version – Limited Commercial Use. 

Libxml2 

This product includes software Copyright (C) 1998-2003 Daniel Veillard.  All Rights Reserved. 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial portions of the 
Software. 
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  IN NO EVENT SHALL THE DANIEL 
VEILLARD BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN 
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION 
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE. 

Except as contained in this notice, the name of Daniel Veillard shall not be used in advertising or otherwise to 
promote the sale, use or other dealings in this Software without prior written authorization from him. 

Microsoft Runtime MSVCP and MSVCR DLLs 
This product includes software © Microsoft Corporation.  All rights reserved.  

NTP 

This product includes code that is Copyright © Tom Horsley, 1997-2004. All rights reserved. The right to 
unlimited distribution and use of this program is granted to anyone who agrees to keep the copyright 
notice intact and not alter the program. 

PortAudio Portable Real - Time Audio Library 

This product includes software Copyright © 1999-2000 Ross Bencina and Phil Burk. All rights reserved.  

Copyright (c) 1999-2000 Ross Bencina and Phil Burk  

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated 
documentation files (the "Software"), to deal in the Software without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to 
permit persons to whom the Software is furnished to do so, subject to the following conditions:  

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND ON INFRINGEMENT.  
IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 
DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR 
OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR 
OTHER DEALINGS IN THE SOFTWARE.  

SOCI 

This product includes software Copyright (C) 2004-2008 Maciej Sobczak , Stephen Hutton. All rights reserved. 

Boost Software License - Version 1.0 - August 17th, 2003 
 
Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and 
accompanying documentation covered by this license (the "Software") to use, reproduce, display, distribute, 
execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to 
whom the Software is furnished to do so, all subject to the following: 
 
The copyright notices in the Software and this entire statement, including the above license grant, this restriction 
and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative 
works of the Software, unless such copies or derivative works are solely in the form of machine-executable object 
code generated by a source language processor. 
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THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE 
COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY 
DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING 
FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE. 

Speex 

This product includes software © 2002-2003, Jean-Marc Valin/Xiph.Org Foundation. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:  

• Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer.  

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution.  

• Neither the name of the Xiph.org Foundation nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission.  

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR CONTRIBUTORS BE LIABLE FOR ANY 
DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS 
OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY 
THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  

SQLite 

Portions of this application were written using SQLite, http://sqlite.org/ 

SRTP 

This product includes software Copyright (c) 2001-2005 Cisco Systems, Inc.  
All rights reserved.  

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the 
following conditions are met:  

• Redistributions of source code must retain the above copyright notice, this list of conditions and the following 
disclaimer. 

• Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 
following disclaimer in the documentation and/or other materials provided with the distribution. 

• Neither the name of the Cisco Systems, Inc. nor the names of its contributors may be used to endorse or 
promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
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WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE 
FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL 
DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR 
SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED 
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

YeaLink 

YeaLink Interface DLL - This product includes software Copyright (C) 2006 Yealink Network Technology Co., 
Ltd. 

 

 

 

 

 


